
Pre-Press Guide



Prepress
Our top tips for optimising  
your designs



COLOUR MANAGEMENT
DTP software settings, paper type, and print finishes 
(lamination, varnish, etc.) all have an impact on colour 
rendering.

CONFIGURING THE COLOUR SETTINGS IN ALL 
YOUR APPLICATIONS

Before synchronising colours using 
Adobe Bridge™, open one of your 
Adobe™ applications to define some 
initial settings (Edit Menu>Colours). In 
Acrobat, you can find this option in the 
preferences section.

1. Select a commonly used RGB 
profile such as sRGB or a profile with 
a large gamut such as ECIRGB-V2 or 
AdobeRGB1998, or a profile suited to 
your input device (digital camera, for 
example). 

2. For the profile, choose ISO Coatedv2, 
Fogra 39L or Fogra 39, which are all 
tailored for sheet-fed offset and digital 
printing on coated paper (Coated Fogra 
27 may also be used).

3. Save these settings so they can be 
loaded into Adobe Bridge™, where 
you can synchronise all your Adobe™ 
applications in one go.

DOWNLOAD AND INSTALL ICC PROFILES

To access the ECI icc profile pack, visit 
www.eci.org. We recommend that you 
use ISO Coated v2 or Fogra 39L for all our 
materials and products.

For PC:
Right click > Install a profile  
(C:/WINDOWS/System32/ 
Spool/Drivers/Color)

For Mac:
Download to Library/ColorSync/Profiles 
(or the Library folder specific to each 
user)

1

2

3

kallkwikwgc.co.uk  |  5

DOWNLOADS:
Download the ECI icc profiles from:
www.eci.org or 
kallkwikwgc.co.uk

http://www.eci.org/en/downloads
https://assets.kkwgc.co.uk/wp-content/uploads/sites/2/2020/04/ColourProfiles.zip


CALIBRATING YOUR SCREEN

Consider the lighting in your office, 
avoid direct light and, in the absence of 
standardised lighting, opt for daylight 
(diffuse).

Linearisation/Basic calibration:
Make sure you have a high-quality 
graphic design monitor and a colour 
calibrator, then launch the procedure 
with a white point of between 5000 and 
6500K, a Gamma of 1.8, and brightness 
of between 100 and 140 cd/m2.

To discuss these topics, and get some expert 
advice, drop us an email: 
sales@kkwgc.co.uk

CONVERTING YOUR IMAGES TO CMYK

We recommend using the “Convert to 
profile” function in Adobe Photoshop™ 
(“Edit” menu).

You could use this function, for example, 
with the ISO Coated V2 300 profile in 
order to set the ink coverage for an image 
to 300%. 

You can play around with the attribution 
or conversion functions depending on 
your preferences. The important thing is 
that you end up with a CMYK conversion 
using, or based on, a recommended 
CMYK profile (ISO Coated, Fogra 39, 
Euroscale Coated, etc.) 

If you prefer to work in RGB we can 
perform the colour space conversion 
for you. Just be aware that if you don’t 
associate any profile with your images 
and objects, we will use the sRGB 
IEC61966-2.1 profile to perform the 
conversion to ISO Coated V2 300.

Convert to profile
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Add a proof to your order

GOOD TO KNOW
To check the colour before printing, opt for the Fogra prepress 
proof  (UGRA/Fogra contract colour proof compliant with ISO 
12647-7). Our certifi cation systems are calibrated and checked 
regularly to ensure that they comply with ISO 12647-7 (ISO 
Coated v2 or Coated Fogra 39 profi les). Each proof includes a 
UGRA/Fogra MediaWedge to allow verifi cation of compliance.

PDF/X FORMAT
In the context of the ISO 15930 standard, we 
recommend that you provide us with a PDFx1a-2001 
file, although we also accept PDF/x3 and PDF/x4 (as well 
as various other PDF formats for printing).

THE 3 BASIC PRINCIPLES

1. You can use the PDF/x-1a-2001profiles 
published by the Ghent PDF WorkGroup 
- www.gwg.org). Add the ISO Coated v2 
profile as the destination/output profile.

2. We ask that you respect the usual 
industry quality standards, such as the 
standards for image resolution, bleed, and 
colour selection (do not use Pantone© or 
other spot colours for 4-colour printing), 
as well as specific constraints relating to 
the product you are working on.

3. Check your PDFs via a soft proof, i.e. 
on the screen (you can also use a printed 
proof). This is an essential step. Don’t 
forget to simulate overprinting content, 
as that’s how the document will appear 
when printed (use Adobe Acrobat™ only).

DOWNLOADING AND  
INSTALLING THE PDF SETTINGS

Visit www.gwg.org to download the 
PDFx1a settings pack that corresponds 
to your software and its version (Adobe™ 
and Quark™).

• GWG sheet-fed digital/offset: 
GWG2012_CMYK_CS5-CC_250ppi

• GWG sheet-fed digital/offset: 
GWG2012_CMYK_CS5-CC_230ppi

Install from File>Adobe PDF Presets 
EXPORT TO PDFX1A-2001 FORMAT
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Add a proof when 
supplying your  
artwork

DOWNLOADS:
Download the GWG PDF  
profiles from:
www.gwg.org or 
kallkwikwgc.co.uk

http://www.gwg.org/application-settings/?search&vendor=all&version=gwg2015&app=all&region=all&segment=all&color=all&precre=all&res=all&submit=Search
https://assets.kkwgc.co.uk/wp-content/uploads/sites/2/2020/04/PDFSettings.zip


DISPALYING PDFs CORRECTLY

1. Once your PDF is open in Acrobat, 
display the output preview  
(Advanced > Print production). 
This will enable you to identify any 
unwanted spot colours, to check the 
ISO Coated V2 output mode (PDFx), 
and to display overprinted content in 
your document (activate / deactivate to 
highlight any errors).

2. You must check your documents by 
displaying overprinted content. You also 
need to view your documents as they 
will be printed on our presses (function 
available in Acrobat™ and other DTP 
software).

We will perform a systematic check on your 
files to verify the formats, bleed, image 
resolution, colour space, etc., just as we 
would with native files.

EXPORT TO PDFX1A-2001 FORMAT

1. When reducing the file size, we 
recommend that you  
deactivate sub-sampling. 
If JPEG compression doesn’t work for 
you, opt for ZIP compression (less 
compact but no alteration).

2. Leave the trim marks only, but make 
sure to include a large border (so that 
the fold marks can be displayed in the 
margins, beyond the bleed).

3. Use the ISO Coated V2 profile as the 
destination profile. RGB objects will be 
converted, but don’t forget to click the 
Ink Manager to convert unused spot 
colours during export.

4. “High resolution” mode produces 
good results.

Check the output 
preview

10  |  kallkwikwgc.co.uk



Graphics Frames

Using XPress™ or InDesign™, apply a 
background colour to graphics frames. 
We recommend white. If you choose 
“no colour” for the background of your 
graphics frame, your images may be 
printed with “gaps” (a kind of matting is 
automatically applied to non-white areas 
in images with no background).

ORIGINALS

Avoid “printed document” or “web image” 
type originals as much as possible. 
Opt for photos, slides, illustrations, 
drawings, or digital originals instead.

IMAGE RESOLUTION

This depends on how the image is to 
be used. When performing fullscale 
printing, it’s better to select a resolution 
of between 300 and 400 pixels per inch. 
A higher resolution is often redundant 
(don’t go higher than 400 dpi for colour 
or greyscale images and 1200 dpi for line 
art).

IMAGE MODE

You can work on your documents in 
the colour mode of your choice, but the 
print file must be converted to CMYK 
(Cyan, Magenta, Yellow, and Black) mode 
before it is saved (if you create PDF/x-1a 
files as per our recommendation, the 
conversion will take place at this stage). 
If you don’t perform the conversion at 
this stage, you risk producing images 
that are dull or that don’t match the 
original colours.

We don’t reject RGB, LAB colour, indexed 
colour, or spot colour files, we just convert 
them to 4-colour mode.

However, our workflow’s automatic 
conversion process may result in 
discrepancies or a loss of image quality. 
It is possible for elements to disappear, 
if in spot colour, during CMYK conversion 
Exception: Some products are always 
processed in spot colour mode, such 
as silkscreened stickers or recyclable 
bags. Envelopes can be printed in either 
4-colour or spot colour mode. 
In Adobe InDesign™ and Acrobat™, 
display the Ink Manager to generate a 
separation preview and thereby detect 
any spot colours before sending the 
order.

FLAWLESS IMAGES
Remember, the resolution 
must be between 200 
and 400 pixels per inch
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SAVING IMAGES

Images must be saved in EPS or TIFF 
format. All other formats, and image 
compression in particular, should be 
avoided, given the risk of compromised 
quality or incompatibility. However, the 
use of CMYK images in JPEG format, at 
maximum quality, gives good results.

IMAGE MAGNIFICATION

In Quark XPress™ or Adobe InDesign™, 
magnification should be close to 100% 
if your scans are good quality. We 
recommend magnification of between 
75% and 130%, depending on image 
resolution. Below 75%, the image 
will take up unnecessary disk space. 
Above 130%, and the image will start to 
pixelate.

MOIRÉ

If there is the risk of moiré artefacts 
appearing in your images (fabrics, for 
example, have a tendency to produce a 
moiré effect) and you want to check how 
they look before printing, here are a few 
pointers:

1. Scan your images at 300 dpi for 150 
lpi halftone images, 350 dpi for 175 lpi 
halftone images, or 400 dpi for 200 lpi 
halftone images.

2. Never resize images when working 
with them in page layout.

3. Check your images in Photoshop™ 
(at a zoom rate between 25% and 50%). 
If you can’t see any signs of moiré in 
your images here, the offset halftones 
should not produce any unwanted moiré 
artefacts when the images are printed. 
However, if you can see a moiré pattern 
in your images on the screen, it will 
definitely appear when they are printed.

Gradients AND Banding

Kall Kwik Welwyn Garden City cannot be 
held responsible for any banding flaws 
that appear on linear or radial gradients 
(this is not caused by an issue with our 
workflow or printing, it’s a mathematical 
phenomenon associated with your file).

Essentially, if you create a gradient with 
many more colour stops than shades 
available in the colour channel or 
channels used (there are 256 shades per 
primary colour, between 0% and 100% - 
256 4 = 16 million colours), your gradient 
will almost certainly appear with obvious 
bands of colour. This phenomenon is 
called banding, and occurs when colour 
stops are repeated several times or when 
the hue difference is not sufficient to 
produce a satisfactory optical effect.

Save your image in  
.eps or .tiff format
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Here are a few tips to minimise banding:

• Choose your hues carefully (don’t 
use a gradient with a small range, 
such as 0% to 20% black, to cover 
a large area – and if you’re creating 
a gradient from black to another 
colour, use a black enriched with 
primary values from the colour at 
the other end of the gradient)

• Use the blended object option in 
Illustrator™ rather than the basic 
“gradient” function, in order to 
reduce repetitions.

• Create a hairline (using a contour 
line or even a fairly thin rectangle 
to indicate the start point and end 
point), and then apply the blended 
object on top.

• As vector graphics applications cause 
more problems than Photoshop™, 
you can also prepare your gradients 
in Photoshop™

• Adding some blur or noise effects 
to gradients can also soften the 
appearance of banding.

• Don’t use JPEG compression or 
reuse JPEG images from the web (can 
cause compression artifacts that 
only complicate matters).

Our final tips: 
For the best results, use our tried and 
tested method:

1. Create a 72 dpi CMYK document in 
16-bit mode (the default is 8 bits = 256 
shades per colour – 16-bit mode is 
intended for specific purposes but has 
the advantage of significantly increasing 
the possible number of shades).

2. Create your gradient to suit your 
requirements (choose an appropriate 
hue and distance).

3. Convert your image to 8-bit mode 
(it will be reconstructed based on 56 
shades per colour more cleanly than if 
you had worked in 8-bit mode from the 
start).

4. Add a small amount of noise or blur if 
required.

5. Add your gradient to the page layout 
(Illustrator™  or InDesign™ ) while 
preserving its resolution.

You will never get a better result with 
sheet-fed offset or digital printing using a 
linear or radial gradient.
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LAYOUT
Plan for printing right from the design stage.

BLEED

When an image or frame is located at 
the edge of a page, you will need to 
use bleed. A bleed is when the image 
or frame is printed beyond the edges 
of the page (3mm minimum for several 
products, but the width may vary), to 
prevent any imperfections caused by 
folding or cutting.

Without bleed, there’s a good chance 
that a white border will appear between 
the image and the edge of the page. 
The same applies for Ben-days (colour 
backgrounds).  
In InDesign™ or Illustrator™, you can 
also specify the full bleed dimensions 
when creating your document (or in the 
Document format menu).

Just because you have used bleed in 
your Adobe (InDesign™ or Illustrator™) 
software, doesn’t mean they will 
necessarily be retained when the 
document is saved to PDF.

When saving the document, always 
check in the marks and bleeds section 
that only the trim marks are checked in 
the marks section and that at least 3mm 
of bleed is specified in the bleed area 
and slug section.

Quiet Zone

These are the internal margins within 
your documents that should be free 
from all text and logos. The quiet zone 
is 3mm in most products, except in 
stapled brochures where we recommend 
a quiet zone of 5mm around the page. For 
perfect-bound brochures, this quiet zone 
should be increased to 10mm.

This margin prevents nasty surprises 
when it comes to binding, shingling 
(creep), folding, or trimming your 
documents.

Borders

If you are planning on having a border 
around your page, it must be at least 
5mm (complete accuracy cannot be 
guaranteed when using a guillotine, and 
this limits the visual impact of even the 
slightest trimming discrepancy). If you 
have decided to add a border to the 
front and reverse, feel free to increase 
the size.

We don’t recommend using white margins 
with brochures.

P.27

TITRE
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TITRE

RICH Black

Solid areas of black won’t be dark 
enough if you use just the colour “black” 
(which is closer to anthracite grey). We 
recommend that you create a specific 
colour composed of 100% Black, 30% 
Cyan, 30% Magenta and 30% Yellow.

K 100% C 30%
M 30%
Y 30%
K 100%

This rich black technique will enhance 
your solid areas of black, making them 
denser and more intense, without 
resulting in overinking.

The pure black (K100%) used in 
vector graphics and fonts prints 
over backgrounds, while rich black 
(C30+M30+Y30+K100 or even 
C1+M0+Y0+K100) behaves like a classic 
hue and knocks out other layers.

We don’t recommend using this method 
with text. 
With large format digital printing, a 100% 
or 400% black (C100+M100+Y100+K100) is 
preferable to a rich black.

BLUE

To avoid producing a blue that is 
too purple, we recommend keeping 
the cyan value 30% higher than the 
magenta value in the ben-day.

Simulating Gold and Silver  
in 4-colour mode

The values indicated below give  
excellent results.

C 5%
M 0%
Y 0%
K 20%

C 0%
M 0%
Y 0%
K 25%

C 5%
M 0%
Y 0%
K 25%

C 5%
M 0%
Y 0%
K 35%

C 0%
M 35%
Y 100%
K 30%

C 10%
M 35%
Y 100%
K 40%

C 10%
M 25%
Y 100%
K 25%

C 25%
M 40%
Y 100%
K 40%
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Yellow

If you are creating your yellow in RGB 
mode, make sure that the Blue value 
is set to 0. During the conversion to 
4-colour mode the blue will become cyan. 
On screen, it will look like your yellow is 
the same, however, when printed, it will 
look GREEN.

Chestnut and chocolate brown

The values indicated below give  
excellent results (none exceed a Total 
Area Coverage of 300%).

C 50%
M 70%
Y 100%
K 60%

C 50%
M 85%
Y 85%
K 60%

C 0%
M 85%
Y 100%
K 60%

C 40%
M 100%
Y 100%
K 55%

C 50%
M 70%
Y 100%
K 75%

C 0%
M 75%
Y 100%
K 60%

C 50%
M 100%
Y 70%
K 75%

C 40%
M 65%
Y 65%
K 60%

BEN-DAY

When you are creating a hue in 4-colour 
mode for use in a solid area, it is better, 
where possible, to restrict yourself to 
just 3 out of the 4 primary colours: 
your hues will be purer and easier to 
reproduce. For solid areas of halftones 
(a beige background, for example), make 
sure that there is at least 20% between 
the Cyan, Magenta and Yellow values, 
and your hue will be more uniform and 
easier to reproduce in the future.

Monitoring INK COVERAGE

Keep an eye on your ink coverage to 
prevent smears during printing or 
finishing. With sheet-fed offset printing, 
we recommend a maximum ink 
coverage of 300% for coated paper and 
280% for all other paper.

C 60%
M 100%
Y 90%
K 75%

C 54%
M 90%
Y 79%
K 75%

C 100%
M 90%
Y 100%
K 80%

C 90%
M 40%
Y 88%
K 80%

If you forget to adhere to this limit, we will 
reduce the Total Area Coverage during file 
standardisation.

IMPORTANT NOTE: This process can 
adversely affect colour; if the colour change 
is undesirable, contact Kall Kwik WGC for 
possible alternatives.

Ink coverage above 
300% highlighted 
by Acrobat

Good to Know!

Add all the primary color values (CMYK) to get your total area coverage. Acrobat can 
show you where there’s too much coverage. With Photoshop, open the ‘Info’ palette 
and use the eye-dropper tool to view the values. You can use an ICC profile to 
ensure that you have the correct ink coverage. In any case, at the point of checking 
your artwork, if your total area coverage is too great, we will reduce it to 300% by 
default.
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Watermarks

To obtain a high-quality rendering of 
watermarks, you must use maximum 
CMYK values of between 5% and 20% 
when printing using uncoated paper.

Uncoated paper (used for letterheads) 
may absorb the ink, which could result 
in dot gain. As a precaution, lower the 
value for black by 50% in order to make 
the image visible on your screen. For 
watermark images in a neutral grey 
rendering, we recommend using black 
only.
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WATERMARKS 
To obtain a high-quality rendering of 
watermarks, you must use maximum 
CMYK values of between 5% and 20% 
when printing using uncoated paper.

Uncoated paper (used for letterheads) may 
absorb the ink, which could result in dot 
gain. As a precaution, lower the value for 
black by 50% in order to make the image 
visible on your screen. For watermark 
images in a neutral grey rendering, we 
recommend using black only.

> Watermark – 7% Black (coated paper)

> Its rendering on uncoated paper

OVERPRINTING
 Be sure to display overprints for your 
documents. This will ensure that you get 
an accurate view of your work before 
they are printed. With certain software, 
“overprinting” (i.e. a transparency 
e� ect) may occur unintentionally for 
certain objects. To avoid nasty surprises 
when it comes to printing, you need to 
double-check that this in your software 
and activate the option for previewing 
overprints in Acrobat™ or your DTP 
software (before sending the order).

 We strongly recommend checking 
any overprinting if you are working in 
Illustrator™ or InDesign™. To do this, go 
to the “View” tab and click “Overprint 
Preview”. If nothing appears on the 
screen, it means you do not have any 
overprinting issues.
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LAYOUT

WATERMARKS 
To obtain a high-quality rendering of 
watermarks, you must use maximum 
CMYK values of between 5% and 20% 
when printing using uncoated paper.

Uncoated paper (used for letterheads) may 
absorb the ink, which could result in dot 
gain. As a precaution, lower the value for 
black by 50% in order to make the image 
visible on your screen. For watermark 
images in a neutral grey rendering, we 
recommend using black only.

> Watermark – 7% Black (coated paper)

> Its rendering on uncoated paper

OVERPRINTING
 Be sure to display overprints for your 
documents. This will ensure that you get 
an accurate view of your work before 
they are printed. With certain software, 
“overprinting” (i.e. a transparency 
e� ect) may occur unintentionally for 
certain objects. To avoid nasty surprises 
when it comes to printing, you need to 
double-check that this in your software 
and activate the option for previewing 
overprints in Acrobat™ or your DTP 
software (before sending the order).

 We strongly recommend checking 
any overprinting if you are working in 
Illustrator™ or InDesign™. To do this, go 
to the “View” tab and click “Overprint 
Preview”. If nothing appears on the 
screen, it means you do not have any 
overprinting issues.

> Watermark - 7% Black (coated paper)

> Its rendering on uncoated paper

Overprinting

Be sure to display overprints for your 
documents. This will ensure that you 
get an accurate view of your work 
before printing. With certain software, 
“overprinting” (i.e. a transparency effect) 
may occur unintentionally for certain 
objects. To avoid nasty surprises when it 
comes to printing, you need to double-
check this in your software by activating 
the option for previewing overprints in 
Acrobat™ or your DTP software (before 
sending the order).

We strongly recommend checking any 
overprinting if you are working in 
Illustrator™ or InDesign™. To do this, go 
to the “View” tab and click “Overprint 
Preview”. If nothing appears on the screen, 
it means you do not have any overprinting 
issues.

TIP
The colour 100% black is always overprinted, which 
is normal. Versions 7 to 9 of Xpress™ and all Adobe™ 
applications are able to display overprinted content 
and it’s with this overprinted content that your 
document will be printed.

Remember, in 
overprinting, white 
becomes transparent
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WATERMARKS 
To obtain a high-quality rendering of 
watermarks, you must use maximum 
CMYK values of between 5% and 20% 
when printing using uncoated paper.

Uncoated paper (used for letterheads) may 
absorb the ink, which could result in dot 
gain. As a precaution, lower the value for 
black by 50% in order to make the image 
visible on your screen. For watermark 
images in a neutral grey rendering, we 
recommend using black only.

> Watermark – 7% Black (coated paper)

> Its rendering on uncoated paper

OVERPRINTING
 Be sure to display overprints for your 
documents. This will ensure that you get 
an accurate view of your work before 
they are printed. With certain software, 
“overprinting” (i.e. a transparency 
e� ect) may occur unintentionally for 
certain objects. To avoid nasty surprises 
when it comes to printing, you need to 
double-check that this in your software 
and activate the option for previewing 
overprints in Acrobat™ or your DTP 
software (before sending the order).

 We strongly recommend checking 
any overprinting if you are working in 
Illustrator™ or InDesign™. To do this, go 
to the “View” tab and click “Overprint 
Preview”. If nothing appears on the 
screen, it means you do not have any 
overprinting issues.
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Front/Reverse Sides

When you provide us with a file or when 
we supply you with a digital prepress 
proof, we’ll always take the front and 
reverse sides as going from right to left. 
Because of this, it’s important to pay 
careful attention to the order in which 
pages are read. This is especially the 
case for documents that are to undergo 
folding or binding at the top (folded 
cards, for example), or documents that 
are flipped from top to bottom (e.g. 
postcards with the front side in portrait 
format and the reverse in landscape 
format).

In the file: 
Page 1 = Front and Page 2 = Reverse

Make sure there is a complete symmetry 
between the front and reverse sides during 
the design process. Use of a control file 
allows you to get a clearer picture of what 
the intended product will look like.

Keylines and Finishing marks

Trim marks: Black hairlines located at 
each corner (outside the border).

Fold marks: Dashed magenta hairlines 
(located outside the border).

Perforation marks: Dashed cyan 
hairlines (located outside the border).

Hairlines used to indicate scoring and 
folding (magenta or cyan hairlines), 
as well as trim marks (black hairlines), 
should be placed outside the bleed 
area, on the front side.

CO
U

PO
N

Crop marks

Creasing / Folding Perforation

1

4

2

3
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Cutting tools

For pocket folders, you can use our 
cutting guide templates, available 
on request. If you decide to create a 
bespoke cutting design, use one of our 
existing templates as a start point, 
and feel free to submit your own 
version for checking to design@kkwgc.
co.uk before sending the order or 
when making a price request. When 
submitting your order, you can send a 
PDF file for printing, another for die-
cutting, and a control file indicating the 
die-cut marks on your image.

Use cyan or magenta dashed lines to 
indicate scoring/creasing marks, and black 
hairlines to indicate trim marks (a weight 
of 0.25 pt is sufficient).

We advise you to create a mock-up in order 
to check the final product.

Specific guidelines apply to laser cutting, 
which is offered for certain products. 
Please ask for further details.

Please be aware that certain limitations 
apply to the conventional die-cutting 
process. If your design goes beyond 
those limits, unfortunately we won’t be 
able to process the order.

Setting up a Spot Varnish?

Please submit a separate file in 100% 
black indicating where the spot varnish 
should be applied (halftones should never 
be used in UV spot varnishing ).  
We don’t recommend using hairlines 
with a weight of under 0.5 pt, or characters 
with a point size of below 7 pt. 

To ensure that your spot varnish 
registers with your CMYK artwork, use 
the layers feature in your application. 
You can also add a contour to your 
varnishes (0.25 pt), to give you a safety 
buffer for the registration process (try 
not to use very thin characters). 

Be careful not to run your spot UV 
varnish across a fold because the 
varnish tends to crack when scored 
and folded. Therefore we recommend 
leaving around 2 - 3mm clear space 
around the fold.

The buffer margin around the spot varnish 
is 0.6 pt.
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Brochures: page numbers & pagination

Use the automatic page numbering 
feature provided by your DTP software 
(this is usually found in the software’s 
page templates). Folios should be placed 
at least 5mm from the edge of the page 
(and always within the quiet zones). If 
you choose to split files, make sure to 
use sections so that automatic page 
numbering is still carried out.

Usually, pages are counted starting from 
the first cover page, the first printed 
folio (no. 3) is therefore on page 3. You 
can also set page numbering to start 
with the number 1 on the first inside 
page of the document (the 3rd page). In 
this case, the cover is not counted. Do 
not number blank pages, even if they 
need to be counted.

Remember that for brochures, the number 
of pages must usually be a multiple of 4, 
regardless of the number of blank pages it 
contains.

Brochures: Right and left-hand pages

For stapled and perfect-bound 
brochures, you can generally use the 
function in your DTP software for 
viewing facing pages together to ensure 
that the pages of the brochure are in the 
correct order (rather than using reader 
spreads or printer spreads).

For other documents (individual sheets, 
posters, and flyers, for example), pages 
should be displayed one under the other 
with surrounding borders.

Odd-numbered pages are always 
on the right-hand page, and even-
numbered pages on the left-hand page. 
The first page is always a right-hand 
page (found alone at the start of the 
document). The last page is also found 
on its own at the end of the document 
(and is a left-hand page). The only 
exception is the cover, which should 
be displayed in a spread, in order to 
facilitate perfect binding.

P.39
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NB:
For brochures, black or grey text should contain black only (100% 
or halftone). If you use rich black (mixed with the 3 primary 
colours), there may be issues when it comes to the registration 
process and your order may be rejected during prepress checks.
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TYPEFACES

CONVERTING TEXT TO 
VECTOR FORMAT:
When you convert your text to vector 
format, you will avoid any problems 
relating to typeface recognition when 
it comes to ripping. It will also eliminate 
potential issues associated with the 
use of fonts that are under license.

 In Illustrator™ and InDesign™, highlight 
your text, then in the “Type” menu, select 
“Create outlines”. 

TYPEFACES

FONTS
The minimum accepted font size 
for text is 4pt, or 7pt if you have 
opted for a light typeface. 
Avoid bitmap fonts and excessively thin 
fonts (Light typeface) if the text is to be 
coated in varnish (no "ultra-light" fonts).
You should also avoid placing white 
text rendered in a light font on solid 
blocks of a single colour in order to 
prevent legibility and display issues 
once the document has been printed.

Non-vectorised text

Vectorised text
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Typefaces

Converting text to vector format:

When you convert your text to vector 
format, you will avoid any problems 
relating to typeface recognition when it 
comes to ripping. It will also eliminate 
potential issues associated with the use 
of fonts that are under license.

In Illustrator™ and InDesign™, highlight 
your text, then in the “Type” menu, select 
“Create Outlines”.

Fonts

The minimum accepted font size for 
text is 4pt, or 7pt if you have opted for 
a light typeface.

Avoid bitmap fonts and excessively thin 
fonts (Light typeface) if the text is to be 
coated in varnish (no “ultra-light” fonts).

You should also avoid placing white text 
rendered in a light font on solid blocks 
of a single colour in order to prevent 
legibility and display issues once the 
document has been printed.Non-vectorised text

Vectorised text
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Recommended software

We recommend that you use 
professional DTP software as opposed 
to standard office software, which is 
not very suitable for high-resolution, 
four-colour printing. However, if you 
provide us with PDF/x-1a files (which 
meet the necessary print requirements), 
you can select your own software, and 
any platform of your choice.

The following is a list of the professional 
software packages that are used most 
often at Kall Kwik WGC and, as such, are 
strongly recommended:

Adobe Photoshop™ 
All versions. Software for 
editing digital images.

Adobe illustrator™ 
All versions. Software 
for creating vector 
illustrations.

Adobe InDesign™ 
All versions. DTP software 
(very useful for brochure 
work).

Adobe acrobat™ 
As of Version 4. Suite of 
software products for 
converting (Distiller), 
editing (Acrobat Pro), and 
viewing (Reader) PDF files.
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TECHNICAL GLOSSARY

BANDING: Stepping effect visible along 
the shades of a gradient.

BEN-DAY: Printing process named after 
American Benjamin Day, who invented 
this technique at the end of the 19th 
century. It involves superimposing 
halftones of primary colours in order to 
obtain a CMYK hue without gradient (for 
example: C20/M10/J0/N0).

BINDING: Binding consists of joining or 
collating one or more folded or non-
folded sheets into a signature.

BLEED (BORDER): Creating a bleed area 
involves extending the content or images 
on a page beyond the final print area so 
that the page is printed without margins 
(3mm minimum for brochure work).

CMYK: Letters designating the four 
primary colours used in printing: Cyan, 
Magenta, Yellow, and Black.

COVER PAGE, FRONT AND REVERSE; 
BACK COVER PAGE, FRONT AND 
REVERSE: Set of external pages that form 
the cover of a document.

COLOUR BLOCK: Printed area comprising 
a solid block of a single colour, either in 
the form of spot inks, or Ben-Day dots.

CREEP: This phenomenon can occur 
when collating sheets into signatures for 
a stapled brochure. When the sheets are 
folded, the width of each sheet increases 
and displacement occurs between the 
edge of the innermost sheet and the edge 
of the outermost sheet. This “creep” can 
become quickly visible during trimming 
if there is text/images positioned on the 
safe margin.

DPI: Dots Per Inch is a convention used 
to define the print quality of a digital 
file (digital printing and imaging). The 
number of dots per inch is a precise unit 
of measure. The higher the number, 
the better the quality. The base screen 
resolution, which determines how an 

image is viewed on screen (whether for 
printing or digital imaging), is defined in 
DPI. 300 DPI is generally used for digital 
photographs destined for print.

DIE-CUTTING TEMPLATE: Custom design 
in which cutting and folding lines are 
displayed in order to produce a particular 
shape (pocket folders, gate folders).

DIGITAL PRINTING: Printing system that 
is controlled directly by a computer.

DTP: Desktop publishing, generally 
abbreviated as DTP, is the set of 
computer processes (PC, software, 
input and writing peripherals, etc.) 
that are used to create documents 
destined for print. It is the logical and 
historical successor of typography and 
photocomposition.

EPS (ENCAPSULATED POSTSCRIPT): A 
document in EPS vector format is a file 
encoded in PostScript language that 
describes the content of an image or 
entire page (text, hairlines, imported 
images). Unlike conventional PostScript, 
which cannot be used for printing, an 
EPS file can be viewed and imported into 
most design, DTP, and layout software.

FACING PAGES FUNCTION: Option that 
allows you to display the left-hand side 
and right-hand side pages of a 2-page 
spread, as in the case of books and 
magazines.

FINISHING: Finishing describes the final 
series of operations – such as folding, 
cutting, collating, inserting, stapling, 
stitching, and binding – that gives the 
printed product its final look and feel.

FOLIO: A page number in a book.

FOUR-COLOUR PROCESS: Four-colour 
process or CMYK (cyan, magenta, yellow, 
black) is a print process that is used to 
reproduce a wide colour spectrum from 
three base colours (cyan, magenta, and 
yellow), to which black is added.

GRADIENT: Progressive transition from 
one shade to another.

HALFTONE: Any colour that is processed 
in four-colour mode is a halftone. If you 
zoom in, you’ll see a multitude of tiny 
dots that combine to form the halftone.

ICC PROFILE: An ICC profile is a 
particular digital file format describing 
the way a computer peripheral renders 
colours. This file type was created by 
the International Color Consortium (ICC) 
to allow DTP professionals to control 
colours right along the graphic chain.

INKING RATE: Or TAC (Total Area 
Coverage). This is the total value of the 
primary colours in a file. If the inking rate is 
too high there is a risk of set-off, the paper 
will be unable to absorb all of the ink.

JPEG (JPG): File format in which images 
are compressed at the expense of a slight 
drop in quality.

KEYLINES: Continuous or dotted lines on 
a document.

LASER CUTTING: Production process 
that consists of cutting paper using laser 
technology.

LIGHT: Term used to describe a character 
written in a “light” typeface.

MOIRÉ: Undesirable visual effect that 
occurs when repeating patterns overlap 
because the screen angle is misaligned. 
Fabric or a document that has already 
been printed can also suffer from the 
moiré effect when reproduced on a press 
(the offset screen is superimposed on the 
image screen).

OFFSET: This process is used in 
conjunction with Lithographic printing. 
The “offset” process refers to the fact 
that an image is “offset” from a plate 
onto a blanket and then onto the paper. 
The lithographic process works on the 
immiscibility of oil and water, therefore 
the oil based ink is attracted to a 
hydrophobic area of a flexible aluminium 
printing plate whilst the water based 
solution (fountain solution) is attracted to 

the hydrophilic area of the plate, allowing 
the image to remain in the desired area.

OVERPRINTING: The overlaying of 2 
colours, deliberately or otherwise.

PAGINATION: The number of pages.

PANTONE®: In contrast to the four-
colour process, which involves the optical 
combination of colour, Pantone involves 
the physical combination of colour, 
i.e. the ink is combined by the press 
operator before printing. As such, the 
original Pantone system was based on 
14 primary colours, as opposed to four. 
The Pantone colour chart, also known 
as the “Pantone Matching System” by 
those in the industry, includes no less 
than 800 colours and provides the mixing 
percentages of the 14 base colours that 
make up their 800 derivatives.

PDF: Portable Document Format, or PDF, 
is a digital file format created by Adobe 
Systems that builds on the PostScript 
format. The advantage of the PDF format 
is that it preserves the fonts, images, 
graphic objects, and layout of all source 
documents, regardless of the application 
or platform that produced it or is used 
to read it. A PDF file allows you to set the 
image and text compression and print 
quality. PDF has become the standard 
format for exchanging and archiving 
electronic documents.

PDF®X: PDF-X is a digital file format 
created by Adobe Systems. The 
specifications of this format ensure the 
reliable exchange of PDF documents in 
the prepress sector. The letter “X” in PDF-X 
stands for Blind eXchange, the objective 
of this format being to allow a “blind 
exchange” of PDF files in any graphic 
production workflow.

PERFECT BINDING: Brochure in which 
the signatures are collated and glued to a 
square-back cover.

PIXELLATION: Pixellation occurs when a 
digital image is enlarged to such an extent 
that the pixels that make up the image 
become visible.
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PREPRESS PROOF: Signed acceptance 
provided by the customer to the printer 
confirming that they agree to proceed 
with printing. A signed prepress proof 
based on a hi-res digital print out, or a 
contract colour proof such as cromalin® 
or matchprint® proof absolves the printer 
of any responsibility in cases where 
errors or omissions are noted after 
printing (we do not produce cromalin 
proofs only colour proofs on a 120gsm 
proofing paper). It constitutes an 
important legal document in the event of 
a dispute.

RGB: Chromatic model used for screen 
display based on an additive colour 
system (whereby the 3 primary colours 
are combined, and the colour white 
formed by light). Never used in offset 
printing.

RIP: In the graphics industry, a Raster 
Image Processor (RIP) is a software utility 
that is used to rasterise data in order to 
make it printable. The RIP forms the link 
between the digital data and the data 
that can be used for printing.

RIPPING: Process of transferring files to 
a RIP.

QUIET ZONE: Area at the border of 
a document in which no key element 
should be placed (neither logos, nor text).

SCORING: Indented crease on 
heavyweight paper to facilitate folding.

SCREEN AND PRINTER FONT: Group 
of files that make up a complete set of 
PostScript fonts.

SCREEN PRINTING: Silkscreen printing 
(from the Latin ‘sericum’ for silk and the 
Greek ‘graphein’ for writing) is a print 
technique that can be used for various 
materials. The technique involves 
spreading ink across a screen (which 
acts as a type of stencil). The ink is then 
deposited onto the material underneath, 
reproducing the open shapes from the 
screen.

SET-OFF: This is the undesired result of 
wet ink transferring from the sheet below 

to the sheet above under pressure. It can 
be caused by the quality of the paper 
(non-porous paper that does not allow 
the ink to absorb, leaving it to collect on 
the surface), the quality of the ink (which 
doesn’t dry fast enough), or excessively 
high ink coverage (more than 300%).

SPOT VARNISHING: Partial coating 
of a printed or non-printed sheet, to 
emphasise the contrast with the material 
used.

SPOT COLOURS: A specific print colour 
other than the four traditionally used 
colours (cyan, magenta, yellow, black). 
Spot colours are most often Pantone 
colours.

SPREAD: A series of pages that are 
assembled together.

SADDLE STITCHED BROCHURE: Brochure 
in which the pages are held together by 
means of metal wires stitched through 
the paper to look like staples.

TIFF (TIF OR .TIFF): Tag(-ged) Image File 
Format, generally abbreviated as TIFF, 
is a file format used for digital images. 
Non-compressed TIFF is a popular format 
and can be read by all raster imaging 
software. TIFF is an extremely flexible 
format.

TRIM MARKS: Small horizontal and 
vertical hairlines that are placed at the 
corners of a document, perpendicular to 
the outer edge. Trim marks are used for 
trimming.

VECTORISING: Process of converting text 
into curves and dots.

WATERMARK: Image produced when 
manufacturing the paper by flattening 
fibres in the sheet to produce a mark 
that becomes visible when held up to the 
light. Watermark image: Image printed 
using a light halftone on the background 
of a page.

we’ve created more identities 
than the passport office...
Creating a brand identity is just one of the many ways we help businesses develop 
their visibility. In a competitive environment the last thing you want to do is merge in 
with the crowd. Our team of designers can help make you memorable, for all the right 
reasons. And it’s not just about having a good logo. How your marketing material looks 
is equally important and we can help your message literally leap out from the page.

You probably know that we can design great looking business cards and leaflets, but 
that’s only part of the story. From books to brochures, annual reports to exhibition 
posters, if you want to stand out rather than merge in why not give us a call?
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